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This symbol is intended to alert the user of important operating and maintenance 
(servicing) instructions in the literature provided with the equipment. 

This symbol is intended to alert the user of the presence of uninsulated dangerous 
voltage within the product enclosure that may present a risk of electric shock. 

Caution
Read Instructions • Read and understand all safety and operating instructions before using the equipment. 

Retain Instructions • The safety instructions should be kept for future reference.

Follow Warnings • Follow all warnings and instructions marked on the equipment or in the user 
information.

Avoid Attachments • Do not use tools or attachments that are not recommended by the equipment 
manufacturer because they may be hazardous. 

Warning
Power sources • This equipment should be operated only from the power source indicated on the product. This 

equipment is intended to be used with a main power system with a grounded (neutral) conductor. The 
third (grounding) pin is a safety feature, do not attempt to bypass or disable it. 

Power disconnection • To remove power from the equipment safely, remove all power cords from the rear of 
the equipment, or the desktop power module (if detachable), or from the power source receptacle (wall 
plug).

Power cord protection • Power cords should be routed so that they are not likely to be stepped on or pinched by 
items placed upon or against them. 

Servicing • Refer all servicing to qualified service personnel. There are no user-serviceable parts inside. To 
prevent the risk of shock, do not attempt to service this equipment yourself because opening or removing 
covers may expose you to dangerous voltage or other hazards. 

Slots and openings • If the equipment has slots or holes in the enclosure, these are provided to prevent 
overheating of sensitive components inside. These openings must never be blocked by other objects. 

Lithium battery • There is a danger of explosion if battery is incorrectly replaced. Replace it only with the 
same or equivalent type recommended by the manufacturer. Dispose of used batteries according to the 
instructions of the manufacturer.

Ce symbole sert à avertir l’utilisateur que la documentation fournie avec le matériel 
contient des instructions importantes concernant l’exploitation et la maintenance 
(réparation).

Ce symbole sert à avertir l’utilisateur de la présence dans le boîtier de l’appareil 
de  tensions dangereuses non isolées posant des risques d’électrocution.

Attention
Lire les instructions• Prendre connaissance de toutes les consignes de sécurité et d’exploitation avant 

d’utiliser le matériel.

Conserver les instructions• Ranger les consignes de sécurité afin de pouvoir les consulter à l’avenir.

Respecter les avertissements • Observer tous les avertissements et consignes marqués sur le matériel ou 
présentés dans la documentation utilisateur.

Eviter les pièces de fixation • Ne pas utiliser de pièces de fixation ni d’outils non recommandés par le 
fabricant du matériel car cela risquerait de poser certains dangers.

Avertissement
Alimentations• Ne faire fonctionner ce matériel qu’avec la source d’alimentation indiquée sur l’appareil. Ce 

matériel doit être utilisé avec une alimentation principale comportant un fil de terre (neutre). Le troisième 
contact (de mise à la terre) constitue un dispositif de sécurité : n’essayez pas de la contourner ni de la 
désactiver.

Déconnexion de l’alimentation• Pour mettre le matériel hors tension sans danger, déconnectez tous les cordons 
d’alimentation de l’arrière de l’appareil ou du module d’alimentation de bureau (s’il est amovible) ou 
encore de la prise secteur.

Protection du cordon d’alimentation • Acheminer les cordons d’alimentation de manière à ce que personne ne 
risque de marcher dessus et à ce qu’ils ne soient pas écrasés ou pincés par des objets.

Réparation-maintenance • Faire exécuter toutes les interventions de réparation-maintenance par un technicien 
qualifié. Aucun des éléments internes ne peut être réparé par l’utilisateur. Afin d’éviter tout danger 
d’électrocution, l’utilisateur ne doit pas essayer de procéder lui-même à ces opérations car l’ouverture ou le 
retrait des couvercles risquent de l’exposer à de hautes tensions et autres dangers.

Fentes et orifices • Si le boîtier de l’appareil comporte des fentes ou des orifices, ceux-ci servent à empêcher 
les composants internes sensibles de surchauffer. Ces ouvertures ne doivent jamais être bloquées par des 
objets.

Lithium Batterie • Il a danger d’explosion s’ll y a remplacment incorrect de la batterie. Remplacer uniquement 
avec une batterie du meme type ou d’un ype equivalent recommande par le constructeur. Mettre au reut les 
batteries usagees conformement aux instructions du fabricant.

Safety Instructions • English

Consignes de Sécurité • Français

Sicherheitsanleitungen • Deutsch
Dieses Symbol soll dem Benutzer in der im Lieferumfang enthaltenen 
Dokumentation besonders wichtige Hinweise zur Bedienung und Wartung 
(Instandhaltung) geben.

Dieses Symbol soll den Benutzer darauf aufmerksam machen, daß im Inneren des 
Gehäuses dieses Produktes gefährliche Spannungen, die nicht isoliert sind und 
die einen elektrischen Schock verursachen können, herrschen.

Achtung
Lesen der Anleitungen • Bevor Sie das Gerät zum ersten Mal verwenden, sollten Sie alle Sicherheits-und 

Bedienungsanleitungen genau durchlesen und verstehen.

Aufbewahren der Anleitungen • Die Hinweise zur elektrischen Sicherheit des Produktes sollten Sie 
aufbewahren, damit Sie im Bedarfsfall darauf zurückgreifen können.

Befolgen der Warnhinweise • Befolgen Sie alle Warnhinweise und Anleitungen auf dem Gerät oder in der 
Benutzerdokumentation. 

Keine Zusatzgeräte • Verwenden Sie keine Werkzeuge oder Zusatzgeräte, die nicht ausdrücklich vom 
Hersteller empfohlen wurden, da diese eine Gefahrenquelle darstellen können.

Vorsicht
Stromquellen • Dieses Gerät sollte nur über die auf dem Produkt angegebene Stromquelle betrieben werden. 

Dieses Gerät wurde für eine Verwendung mit einer Hauptstromleitung mit einem geerdeten (neutralen) 
Leiter konzipiert. Der dritte Kontakt ist für einen Erdanschluß, und stellt eine Sicherheitsfunktion dar. Diese 
sollte nicht umgangen oder außer Betrieb gesetzt werden. 

Stromunterbrechung • Um das Gerät auf sichere Weise vom Netz zu trennen, sollten Sie alle Netzkabel 
aus der Rückseite des Gerätes, aus der externen Stomversorgung (falls dies möglich ist) oder aus der 
Wandsteckdose ziehen.

Schutz des Netzkabels • Netzkabel sollten stets so verlegt werden, daß sie nicht im Weg liegen und niemand 
darauf treten kann oder Objekte darauf- oder unmittelbar dagegengestellt werden können.

Wartung • Alle Wartungsmaßnahmen sollten nur von qualifiziertem Servicepersonal durchgeführt werden. 
Die internen Komponenten des Gerätes sind wartungsfrei. Zur Vermeidung eines elektrischen Schocks 
versuchen Sie in keinem Fall, dieses Gerät selbst öffnen, da beim Entfernen der Abdeckungen die Gefahr 
eines elektrischen Schlags und/oder andere Gefahren bestehen.

Schlitze und Öffnungen • Wenn das Gerät Schlitze oder Löcher im Gehäuse aufweist, dienen diese zur 
Vermeidung einer Überhitzung der empfindlichen Teile im Inneren. Diese Öffnungen dürfen niemals von 
anderen Objekten blockiert werden.

Litium-Batterie • Explosionsgefahr, falls die Batterie nicht richtig ersetzt wird. Ersetzen Sie verbrauchte 
Batterien nur durch den gleichen oder einen vergleichbaren Batterietyp, der auch vom Hersteller 
empfohlen wird. Entsorgen Sie verbrauchte Batterien bitte gemäß den Herstelleranweisungen.

Este símbolo se utiliza para advertir al usuario sobre instrucciones importantes 
de operación y mantenimiento (o cambio de partes) que se desean destacar en el 
contenido de la documentación suministrada con los equipos.

Este símbolo se utiliza para advertir al usuario sobre la presencia de elementos 
con voltaje peligroso sin protección aislante, que puedan encontrarse dentro de la 
caja o alojamiento del producto, y que puedan representar riesgo de electrocución. 

Precaucion
Leer las instrucciones • Leer y analizar todas las instrucciones de operación y seguridad, antes de usar el 

equipo.

Conservar las instrucciones • Conservar las instrucciones de seguridad para futura consulta.

Obedecer las advertencias • Todas las advertencias e instrucciones marcadas en el equipo o en la 
documentación del usuario, deben ser obedecidas.

Evitar el uso de accesorios • No usar herramientas o accesorios que no sean especificamente recomendados 
por el fabricante, ya que podrian implicar riesgos. 

Advertencia
Alimentación eléctrica • Este equipo debe conectarse únicamente a la fuente/tipo de alimentación eléctrica 

indicada en el mismo. La alimentación eléctrica de este equipo debe provenir de un sistema de distribución 
general con conductor neutro a tierra. La tercera pata (puesta a tierra) es una medida de seguridad, no 
puentearia ni eliminaria. 

Desconexión de alimentación eléctrica • Para desconectar con seguridad la acometida de alimentación eléctrica 
al equipo, desenchufar todos los cables de alimentación en el panel trasero del equipo, o desenchufar el 
módulo de alimentación (si fuera independiente), o desenchufar el cable del receptáculo de la pared.

Protección del cables de alimentación • Los cables de alimentación eléctrica se deben instalar en lugares donde 
no sean pisados ni apretados por objetos que se puedan apoyar sobre ellos. 

Reparaciones/mantenimiento • Solicitar siempre los servicios técnicos de personal calificado. En el interior no 
hay partes a las que el usuario deba acceder. Para evitar riesgo de electrocución, no intentar personalmente 
la reparación/mantenimiento de este equipo, ya que al abrir o extraer las tapas puede quedar expuesto a 
voltajes peligrosos u otros riesgos. 

Ranuras y aberturas • Si el equipo posee ranuras o orificios en su caja/alojamiento, es para evitar el 
sobrecalientamiento de componentes internos sensibles. Estas aberturas nunca se deben obstruir con otros 
objetos.

Batería de litio • Existe riesgo de explosión si esta batería se coloca en la posición incorrecta. Cambiar esta 
batería únicamente con el mismo tipo (o su equivalente) recomendado por el fabricante. Desachar las 
baterías usadas siguiendo las instrucciones del fabricante.

Instrucciones de seguridad • Español

Precautions

安全须知 • 中文
这个符号提示用户该设备用户手册中有重要的操作和维护说明。

这个符号警告用户该设备机壳内有暴露的危险电压，有触电危险。

注意
阅读说明书 • 用户使用该设备前必须阅读并理解所有安全和使用说明。

保存说明书 • 用户应保存安全说明书以备将来使用。

遵守警告 • 用户应遵守产品和用户指南上的所有安全和操作说明。

避免追加 • 不要使用该产品厂商没有推荐的工具或追加设备，以避免危险。

警告
电源 • 该设备只能使用产品上标明的电源。 设备必须使用有地线的供电系统供电。 第三条线

（地线）是安全设施，不能不用或跳过 。

拔掉电源 • 为安全地从设备拔掉电源，请拔掉所有设备后或桌面电源的电源线，或任何接到市电
系统的电源线。

电源线保护 • 妥善布线， 避免被踩踏，或重物挤压。

维护 • 所有维修必须由认证的维修人员进行。 设备内部没有用户可以更换的零件。为避免出现触
电危险不要自己试图打开设备盖子维修该设备。

通风孔 • 有些设备机壳上有通风槽或孔，它们是用来防止机内敏感元件过热。 不要用任何东西
挡住通风孔。

锂电池 • 不正确的更换电池会有爆炸的危险。必须使用与厂家推荐的相同或相近型号的电池。按
照生产厂的建议处理废弃电池。



FCC Class A Notice

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 15 
of the FCC Rules. Operation is subject to the following two conditions: 

1.	 This device may not cause harmful interference.

2.	 This device must accept any interference received, including interference that may cause undesired operation. 

The Class A limits are designed to provide reasonable protection against harmful interference when the equipment 
is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the user guide, may cause harmful interference to radio communica-
tions. Operation of this equipment in a residential area is likely to cause harmful interference, in which case the user is 
required to correct the interference at his own expense.

NOTE: 	 This unit was tested with shielded cables on the peripheral devices. Shielded cables must be used with 
the unit to ensure compliance with FCC emissions limits. 
 

For more information on safety guidelines, regulatory compliances, EMI/EMF compliance, accessibility, and 
related topics, click here.

The following advisories are used in the guide and have the following meanings:

TIP:	 A tip provides a suggestion to make setting up or working with the device easier.

NOTE:	 A note draws attention to important information.

CAUTION:	 A caution warns of things that might damage the equipment.

WARNING:	 A warning alerts the user to things that might cause injury, death, or other severe consequences.

Copyright
© 2010 Extron Electronics. All rights reserved.

Trademarks
All trademarks mentioned in this guide are the properties of their respective owners.

http://www.extron.com/download/download.aspx?type=file&material=6&id=Extron%20Safety%20and%20Regulatory%20Compliance%20Guide
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Introduction

This guide describes the function, installation and operation of the TouchLink TLP 700MV 
and TLP 700TV panels. The guide also provides information about optional accessories that 
are available from Extron for both panels.

Unless otherwise stated, the terms “TLP 700 series” and “TLP 700” refer to both models.

About the TLP 700MV and TLP 700TV
The Extron TLP 700MV is a wall mounted TouchLink panel. The screen displays graphic 
objects and text, which are associated with user-defined functions. The touch overlay 
allows the user to initiate or activate functions by touching the objects on the screen. 

The TLP 700TV comes with a stand that allows it to be placed on a desktop. If the 
stand is removed, the unit can be VESA® mounted on a wall or furniture, using the 
Extron VM 700T kit (part number 70-692-01) or the Extron LPVM-1 kit (part number 
60-1099-02).

Both units have ten push buttons (five along each side of the screen) and an encoder knob 
that allow common, user-defined functions to be activated and calibrated independently 
of the LCD screen. The units can be customized by using a bezel kit to cover the buttons, 
the encoder knob, or both.

A motion sensor, light sensor, and a speaker provide auto dimming, sleep mode, and 
audible feedback.

The GUI Configurator software allows the user to design the screen layout by selecting 
from existing templates or designing entirely new interfaces on their PC and uploading 
the completed project to the TouchLink panel. The user can define the graphics and the 
functions associated with those graphics, providing versatility and adaptability to the 
configuration and control of an A/V system.
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Figure 1.	 TLP 700MV Application Diagram

Features
7-inch LCD screen — displays a range of graphic objects and text on an 800 x 480 pixel 
screen.

Touch screen overlay — provides simple and intuitive control over a range of functions 
by touching the icons displayed on the screen.

Video preview — allows composite or S-video previews.

GUI Configurator and Global Configurator Software — allows the user to design a 
custom graphical user interface and associate a range of different functions with objects in 
that display. No programming knowledge is needed.

Easy configuration and flexibility — on-screen graphics and text, as well as the 
functions associated with them, can be easily changed to adapt the control panel to the 
evolving needs of the system, avoiding the need for additional control modules.

Ten buttons — for common, user-defined functions.

Ethernet connection — provides an inexpensive, easily installed, cabling option for 
connecting products located anywhere else on the network. 

Compatible with most Extron IP Link® products — allows easy integration into 
existing systems.

Front panel encoder knob — primarily for volume control, but can be configured for 
other functions.

Light sensor — adjusts LCD screen backlighting to compensate for ambient lighting.

Motion sensor — When no motion is detected for a user-defined period of time, the 
unit enters sleep mode to conserve power. When a user approaches the screen, the panel 
detects motion and is reactivated.

Loudspeaker — provides audible feedback in response to events triggered by the user.
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Multiple mounting options — The TLP 700MV can be wall-mounted, rack-mounted, or 
furniture‑mounted.

The TLP 700TV comes with a stand that allows it to be placed on a desktop. If the stand is 
removed, the unit can be VESA‑mounted on a wall or furniture using either of the optional 
Extron kits.

See the list of optional parts on page 37 for the part numbers.

Color Options for TLP 700MV — The TLP 700MV is available in different color versions.

Customization kits — A range of kits are available to customize the TouchLink panel. See 
the list of optional parts on page 37 for the part numbers.

Requirements

Software
The following minimum system requirements are recommended for running 
GUI Configurator or Global Configurator 3:

zz Operating System – Microsoft® Windows® XP SP2, Windows Vista®, or Windows 7

zz CPU – Intel® Pentium® III 1 GHz processor

zz Memory – 1 GB of RAM

zz Hard Disk space – 100 MB

zz Microsoft .NET Framework 2.0

zz Screen Resolution – 1024 x 768 resolution at 32‑bit color

zz Network Connection – Data transfer rate of 10 Mbps, 100 Mbps recommended

Hardware
An Extron IP Link control interface must also be connected to the same network domain as 
the TouchLink panel. Suggested models include:

zz IPL T S series (for example, the IPL T S4)

zz IPL 250

zz IPL T CR48

zz IPL T SFI244
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Panel Features

This section describes:

TLP 700MV Front Panel Features and Operations

TLP 700MV Rear Panel Features and Connections

TLP 700TV Front Panel Features and Operations

TLP 700TV Rear Panel Features and Connections

TLP 700MV Front Panel Features and Operations
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Figure 2.	 TLP 700MV Front Panel

a	 Buttons — These ten backlit push-buttons (five on either side of the screen) can be 
configured to execute user-defined functions using the Extron Global Configurator 
software (page 25). For information about creating button labels, see page 47.

b	 Motion Sensor — is capped with a small Fresnel lens that focuses light onto the 
sensor. When no motion has been detected for a user-defined period of time, the unit 
goes into sleep mode. When motion is detected in the vicinity of the panel, the screen 
display is restored and all buttons are active.

c	 Encoder Knob — controls the volume but it can be configured for other functions.

d	 Light Sensor — monitors the level of ambient light and adjusts the screen brightness 
and button backlighting.

e	 LCD screen — has an 800 x 480 resolution with a touch overlay. A graphic user 
interface is designed using the Extron GUI Configurator software to display 
buttons, text, or icons on the screen (page 21). These can be configured for a range of 
user-defined functions, using the Extron Global Configurator software (page 26).

f	 Speaker — A single 2 watt speaker provides audible feedback for the user.
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There are three buttons recessed behind the bezel. These buttons are used to configure 
the unit and reset parameters to factory defaults:
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Figure 3.	 TLP 700MV Front Panel with Bezel removed

g	 Reboot button — shuts down and restarts the unit without changing any of the 
parameters.

h	 Reset button — allows the unit to be reset in any of four different modes. For further 
information see “Reset Modes” on page 46.

i	 Menu button — activates the on-screen menus for calibrating the unit (see 
page 11).

j	 Reset LED — is visible only when the bezel has been removed. It lights as an indicator 
for the Reset modes. For further information see “Reset Modes” on page 46.
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TLP 700MV Rear Panel Features and Connections

11

12

13

Figure 4.	 TLP 700MV Rear Panel Features

k	 Power Connector — Connect the two pole, 3.5 mm captive screw connector from 
the provided power supply to the power supply socket on the rear panel. Ensure the 
connections have the correct polarity as shown below:

 

12V
0.4A MAX

POWER
Power Receptacle

DC Power Cord 
Captive Screw Connector

AC Power Cord

Ground  
+12 VDC 

External 
Power Supply
(12 VDC, 1 A )

SECTION  A–A

RidgesSmooth

Power Supply
Output Cord

AA

12V
0.4A MAX

POWER

3/16"
(5 mm) Max.

Figure 5.	 Power Supply Connection

CAUTION: 	 Always use a power supply supplied by or specified by Extron. Use of an 
unauthorized power supply voids all regulatory compliance certification 
and may cause damage to the supply and the end product. Extron power 
supplies are certified to UL/CSA 60950-1 and are classified as LPS (Limited 
Power Source). Use of a non-LPS or unlisted power supply will void all 
regulatory compliance certification. 
 

Unless otherwise stated, the AC/DC adapters are not suitable for use in 
air handling spaces or in wall cavities. The power supply is to be located 
within the same vicinity as the Extron A/V processing equipment in an 
ordinary location, Pollution Degree 2, secured to the equipment rack 
within the dedicated closet, podium or desk. 
 

The installation must always be in accordance with the applicable 
provisions of National Electrical Code ANSI/NFPA 70, article 75 and the 
Canadian Electrical Code part 1, section 16. The power supply shall not be 
permanently fixed to building structure or similar structure.
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NOTES:	 The length of the exposed wires in the stripping process is critical. The 
ideal length is 3/16 inches (5 mm). Any longer and the exposed wires may 
touch, causing a short circuit between them. Any shorter and the wires 
can be easily pulled out even if tightly fastened by the captive screws. 
 
Do not tin the wires. Tinned wire does not hold its shape and can become 
loose over time.

l	 Video Input — Connect an S-video or composite video source 
to the unit, using these two BNC connectors:

zz For S-video, connect the Y (luminance) signal to the VID/Y 
input and the C (chrominance) signal to the C input.

zz For composite video, connect the input to the VID/Y input.

m	 Network Connector — The TLP 700MV connects to an Ethernet 
LAN using a twisted pair cable, terminated with an RJ-45 connector 
(see the figure at right). Use a straight-through Ethernet cable to 
connect the panel to a switch or router. Use a crossover cable to 
connect the panel directly to a computer.

Plug one end of the cable into the RJ-45 socket and the other 
end into a network switch, hub, or router that is connected to an 
Ethernet LAN or the Internet.

An Extron IP Link control interface must also be connected to the 
same network domain. Suggested models are listed on page 3.

The LAN Port connector (see the figure at right) has two LED lights. 
The Link LED lights green to indicate a good network connection. 
The Activity LED blinks yellow when network activity occurs. 

LAN

RJ-45
Port

Link
LED

Activity
LED

LAN Port
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TLP 700TV Front Panel Features and Operations

1

4

5

6

2

3

7

8
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Figure 6.	 TLP 700TV Front Panel Features

a	 Buttons — These ten backlit push-buttons (five on either side of the screen) can be 
configured to execute user-defined functions using the Extron Global Configurator 
software (page 25). For information about creating button labels, see page 47.

b	 Motion Sensor — is capped with a small Fresnel lens that focuses light onto the 
sensor. When no motion has been detected for a user-defined period of time, the unit 
goes into sleep mode. When motion is detected in the vicinity of the panel, the sleep 
mode is overridden and the screen display is restored.

c	 Encoder Knob — controls the volume but it can be configured for other functions.

d	 Light Sensor — monitors the level of ambient light and adjusts the screen brightness 
and button backlighting.

e	 LCD screen — has an 800 x 480 resolution with a touch overlay. A graphic user 
interface is designed using the Extron GUI Configurator software (page 21) to 
display buttons, text, or icons on the screen. These can be configured for a range of 
user-defined functions, using the Extron Global Configurator software (page 25).

f	 Speaker — A single 2 watt speaker provides audible feedback for the user.

g	 Reset button — recessed behind the bezel. It allows the unit to be reset in any of 
four different modes. For further information see “Reset Modes” on page 46.

h	 Menu button — recessed behind the bezel. It activates the on-screen menus for 
calibrating the unit (see page 11).

i	 Reset LED — recessed behind the bezel. It lights as an indicator for the Reset modes. 
For further information see “Reset Modes” on page 46.
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TLP 700TV Rear Panel Features and Connections

With Stand Attached

10 13

11 12

Figure 7.	 TLP 700TV Rear Features

The following connections are available through the back panel when the stand is in place:

j	 LED lights —The Link LED lights green to indicate a good network connection. The 
Activity LED blinks yellow when network activity occurs.

k	 RJ 45 connector to LAN — Use straight-through twisted pair cable to connect the 
TLP 700TV to a network switch or router. Use a crossover cable to connect the panel 
directly to a PC. An Extron IP Link control interface must be connected to the same 
network domain. A list of suggested models is given on page 3.

l	 Power connector — Connect the provided power supply to this 2-pole captive 
screw connector. See the Caution on page 8 and the Notes on page 9 for important 
information about the power supply.

m	 RJ 45 connector to Extron MTP Transmitter — Twisted pair input provides video 
and audio input.

CAUTION: 	 The left RJ-45 connector on the back of the TLP 700TV (with the 
yellow and green LEDs) must be connect to a network. The right 
RJ‑45 connector must be connected to an Extron MTP Transmitter. The 
MTP transmitter uses higher voltages than a LAN and inputting those 
voltages on the network connection damages the TLP 700TV.

NOTE:	 Audio input is available only from an Extron MTP transmitter through the 
RJ-45 connector in the base of the unit. If the base is removed from the 
TLP 700TV, connections are via BNC connectors and there is no audio 
input.
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TLP 700TV Base Features
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Figure 8.	 TLP 700TV Base Features

The TLP 700TV stand, which can be removed for VESA mounting, has:

q	 Three adjustable potentiometers — These are used to control sharpness and gain 
for both S-video luminance (Y) and S-video chrominance (C). If a composite video 
signal is being used, the gain is controlled by the center potentiometer (Vid/Y).
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Figure 9.	 TLP 700TV Potentiometers

r	 Access for disconnecting RJ-45 connectors — When RJ-45 connectors are covered 
with a protective boot, it can be difficult to remove them from their sockets. The two 
holes are directly underneath the two RJ-45 jacks (see figure 7). Pushing the tip of a 
pen or pencil through the holes makes it easy to disconnect the RJ-45 connectors.

s	 Security mounting — If required, secure the unit to the desktop, using two 
screws, as described on page 41.
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Initial Calibration

This section describes:

zz How to Access the Internal On-screen Menus

zz The Main, Volume, Time, Network, and Video Screens

zz The Screen Touch Calibration Screen

How to Access the Internal On-screen Menus
When power is first applied to the TouchLink Panel, the unit boots up and displays the 
opening screen. To access the on-screen menus, press the Menu button, which is located 
below the screen (see page 5 for the TLP 700MV or page 8 for the TLP 700TV).

The menus open at the Main screen. There are five different screens (Main, Volume, 
Time, Network, and Video) that can be selected by pressing the appropriate button at 
the left side of the screen. 

There is also an Exit button at the bottom left corner of the screen for leaving the 
menus.

Main Screen

The Sleep timer determines how long the panel is inactive before it enters Sleep mode, 
when the screen goes dark to save power. Press the Down or Up buttons to highlight 
the Sleep timer options and continue to use the buttons or use the volume control knob 
to adjust the time from 0 to 50,000 seconds (in 10-second increments). The time that is 
currently selected is shown above the buttons.

The screen may need a high level of backlighting to read the screen when ambient lighting 
is high. With low ambient lighting, the backlighting should be low.

Auto Backlight provides a suitable amount of backlighting that is automatically calculated 
from the amount of ambient light detected by the light detector.
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When Auto Backlight is set to Off, the Backlight option allows the backlighting to be 
set manually from 0 to 100%. Press the Down or Up buttons to highlight the Backlight 
options and use the volume control knob or press the Down or Up buttons to adjust the 
backlighting. The current value is shown above the buttons.

NOTE:	 When Auto Backlight is set to On, changing the percentage of Backlight does 
not affect the amount of backlighting.

LED Backlight lights the ten buttons next to the screen.

Wake on Motion activates the panel from Sleep mode when motion is detected near the 
unit.

Use the on-screen buttons to toggle the Auto Backlight, LED Backlight, or Wake on 
Motion options between Off and On.

Volume Screen

Click on the Down or Up buttons to highlight one of the adjustable audio features. Use 
the Down and Up buttons or the volume control knob to adjust:

zz Master volume (between 0 and 255) sets the maximum volume for all the other 
sound volume settings. For example, if the master volume is set to 200 (approximately 
80% of maximum), even when the Line In volume is set to 255 (maximum), it is only 
equivalent to 80% of maximum.

zz Click (between 0 and 255) sets the volume for audible feedback that accompanies 
events such as a side button or screen button being pressed.

zz Sounds (between 0 and 255) sets the volume of audio from any audio file playback.

zz Line In (between 0 and 255) sets the volume of the audio signal received through the 
line in from and Extron MTP transmitter.
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Time Screen

Click on the Down or Up buttons to highlight one of the adjustable time settings. Use the 
Down and Up buttons or the volume control knob to adjust the Month, Day, Year, Hours, 
and Minutes.

NOTE:	 The Hours value uses the 24 hour clock. For 10 am, set Hours to 10; for 10 
pm, set Hours to 22.

Network Screen

Set the IP Address or Subnet Mask by pressing the appropriate button. An on‑screen 
keypad appears that allows the user to enter digits from 0 through 9 or “.” (dot). In the 
event of an error, the user can clear the field.

NOTE:	 The factory default IP address for the TLP 700MV is 192.168.254.254. The 
default subnet mask is 255.255.0.0. Consult with your IT Department to 
ensure these addresses are correctly assigned.

Toggle between On and Off to enable or disable Dynamic Host Configuration Protocol 
(DHCP). This determines whether the unit has a permanent IP address or has one provided 
by the network, when required. The default setting is off.
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Video Screen

The small gray rectangle provides a video preview window that allows the user to adjust 
the video properties.

Click on the Down or Up buttons to highlight one of the adjustable video settings. Use the 
Down and Up buttons or the volume control knob to adjust:

zz Contrast between 0 and 127 (default, 64)

zz Color between 0 and 127 (default, 64)

zz Brightness between 0 and 255 (default, 128)

zz Tint between 0 and 255 (default, 128)

Touch Calibration Screen
After setting the values, press the Menu button a second time to calibrate the touch area 
of the Touchpanel.

Press on the green box until the color reverts to gray with a white border and a second 
box is highlighted. Repeat until all four boxes have been pressed and calibrated. At that 
point the screen returns to the Main screen (see page 11).

To exit from the on-screen menus, press the Exit button in the bottom left corner of the 
menu screens.
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Control Software

This section of the guide discusses the software and firmware needed to set up the 
Touchpanel units:

zz Software Overview

zz Installing the Software

zz Updating the Firmware

zz Using the TouchLink Panel Web Pages

zz Using GUI Configurator

zz Using Global Configurator

Software Overview
Designing a graphical user interface (GUI) for the TouchLink Panel takes two steps:

zz Design the layout of the text and graphics using GUI Configurator

zz Assign functions to the text and graphics using Global Configurator

The touchpanel screen is designed using GUI Configurator either by customizing an 
existing template or by designing an entirely new interface. GUI Configurator offers 
several templates that are designed to manage control system devices.

After the GUI has been designed on a PC, the project is saved, built, and uploaded to the 
TLP unit to verify what it looks like on the screen. It is then imported from the TLP unit to 
Global Configurator where control functions are assigned to the text and graphic items in 
the layout. After assigning the control functions, the project is rebuilt and uploaded to the 
IP Link control interface.

These two programs provide versatility and adaptability for configuration and control of an 
A/V system as it grows and evolves.
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Installing the Software

Installation from the Extron Disc
Insert the disc provided into the DVD-ROM drive of the computer. If the setup program 
does not start automatically, run Launch.exe from the DVD-ROM directory in Windows 
My Computer. Select the Software tab, locate the GUI Configurator program and 
click Install. Follow the on-screen instructions. 

By default, the Installer program creates and places the GUI Configurator program in the 
C:\Program Files\Extron\GUI Configurator folder. An icon may also be 
placed on the Windows desktop.

If required, locate the Global Configurator program on the disc or web site and install it. 
By default, the Installer program creates and places the Global Configurator program in 
the C:\Program Files\Extron\GCx.x folder, where x.x represents the current 
version of the Global Configurator program. During installation, there is an option to place 
an icon on the Windows desktop.

Installation from the Extron Web Site
Both programs can be downloaded from the Extron web site (www.extron.com). Select 
the Download tab and click on the Software option in the sidebar at the left.

Figure 10.	Extron Web Site Download Center

Navigate to GUI Configurator or Global Configurator and click Download next to the 
program. Follow the on‑screen instructions to complete installation. A folder is created on 
the C drive and an icon may be placed on the desktop.
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Updating the Firmware
Firmware for the TLP 700 can be upgraded using the Extron Firmware Loader or using 
your web browser. Before starting, consult your IT team and ensure that the TLP 700 
has a unique IP address.

Updating Firmware Using the Extron Firmware Loader Utility

NOTES:	 To use this method, you must have Extron Firmware Loader installed on your 
PC. The program can be downloaded and installed, free of charge, from the 
Extron web site, or the DVD (provided). Follow the directions given on page 
16 for downloading and installing GUI Configurator and Global Configurator. 
 

Your PC must have internet access and be on the same network as the 
TouchLink Panel.

1.	 On the Extron web site, select the Download tab and click on the Firmware option 
in the menu bar at the left of the screen (see Figure 10 on page 16).

2.	 Navigate to the TLP 700 firmware and click Download.

3.	 The firmware downloads to your computer. 

NOTE:	 Make a note of the folder in which the firmware file is saved.

4.	 Open the Extron Firmware Loader. The Add Device... window opens.

5.	 Select TLP 700MV or TLP 700TV from the device list.

6.	 Select TCP/IP from the connection method.

7.	 Enter the IP address for the TLP 700, a Telnet port number, and, if necessary, the 
administrator password. Click OK.

The device name appears in the connected device box with a green check mark.

8.	 Use the Browse button to locate the Firmware file that you downloaded in step 3.

9.	 Click the Add button. The main Firmware Loader window comes into focus with the 
TLP 700 in the device list.

10.	Highlight the TLP 700 and click on the Begin button. The firmware transfer begins 
and the progress is shown by a green bar in the Total Progress pane.

11.	When “Total Progress” shows 100% and Completed, exit the Firmware Loader.

12.	When the firmware is installed, calibrate the panel, using the on-screen menus (see 
page 11) or the TouchLink panel web pages (see page 19).
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Updating Firmware From a Web Browser

NOTES:	 Your PC must have internet access and be on the same network as the 
TouchLink Panel.

1.	 On the Extron web site, select the Download tab and click on the Firmware option 
in the menu bar at the left of the screen (see Figure 10 on page 16).

2.	 Navigate to the TLP 700 firmware and click Download.

3.	 The firmware downloads to your computer. 

NOTE:	 Make a note of the folder in which the firmware file is saved.

4.	 Open your browser and type the IP address of the TLP 700 unit into the address box. 
The browser opens the TouchLink Panel web pages (see page 19).

5.	 Click on the Configuration tab at the top of the page. Select Firmware 
Upgrade from the bar on the left. If prompted, enter the administrator password.

Figure 11.	 Firmware Upgrade Web Page

6.	 Use the Browse button to navigate to the firmware file (see step 3).

7.	 Click Upload. The Touchpanel screen shows the message “Firmware Uploading... 
Please Wait...”. The TouchLink Panel restarts after the firmware is loaded.

8.	 When the firmware is installed, calibrate the panel, using the on-screen menus (see 
page 11) or the TouchLink panel web pages (see page 19).
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Using the TouchLink Panel Web Pages
As seen in the previous section, the TLP 700MV and TLP 700TV TouchLink Panels have 
default web pages that can be used to read and change the current settings of the panels. 
The web pages can be accessed as follows:

1.	 Open your browser and type the IP address of the TLP 700 unit into the address box. 
The browser opens the TouchLink Panel Status page, which is read-only and provides 
basic information about the model, date and time, and IP settings.

Figure 12.	 TLP 700 Status Tab

2.	 Click on the Configuration tab and select the System Settings page, which 
allows the user to modify information about the IP settings and the date and time 
settings. These correspond to the Network settings (see page 13) and Time settings 
(see page 13) in the on-screen menus.

Figure 13.	 TLP 700 Configuration Tab: System Settings Page
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3.	 Selecting the Passwords page allows the user to set passwords for an Administrator 
and a User. To set a password, follow the instructions at the top of the page. 

Figure 14.	 TLP 700 Configuration Tab: Passwords Page

4.	 To upgrade the unit firmware, select Firmware Upgrade and follow the 
instructions on page 18.

5.	 Click on the Touchpanel tab, which allows the user to alter the TouchLink panel 
and volume settings. These correspond to the Main settings (see page 11) and 
Volume settings (see page 12) in the on-screen menus.

Figure 15.	 TLP 700 Touchpanel Tab: Configuration Page
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Using GUI Configurator
This section provides an overview of the GUI Configurator program. For complete 
information about the program, consult the GUI Configurator help file (click on 
Contents in the Help menu or press the <F1> key while within the program).

To use the GUI Configurator program, follow these instructions:

1.	 Click on the desktop icon. The program opens at the main screen with the GUI 
Configurator Start Options dialog box in front.

Figure 16.	 GUI Configurator: Main and GUI Configurator Start Options 
Screens

Figure 17.	 GUI Configurator Start Options Dialog Box
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2.	 You can choose to:

zz Start a New Project — Clicking OK opens a dialog box that offers a choice of 
project options.

Figure 18.	GUI Configurator New Project Dialog Box

A series of icons offer you the choice of creating a project with a template 
or without a template and allow you to select the size and type of Touchlink 
Panel. If you are creating a project from an existing template, you can use the 
factory‑loaded templates or you can select a template that you have previously 
created.

zz Open an Existing Project — Clicking OK opens a dialog box that allows you to 
navigate to an existing project for modification.

Figure 19.	GUI Configurator Dialog Box to Open an Existing Project

Navigate to the existing file and select it. A preview with information about the 
file appears in the pane on the right.

If you are working on the project, leave the Open as read-only box 
unchecked.

Click Open to open the file. The project opens in GUI Configurator.
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zz Download an Existing Project from a Panel — Clicking OK opens a dialog box 
that allows you to download a file that has been uploaded to a panel.

Figure 20.	GUI Configurator Download Project Dialog Box

In the dialog box that opens, enter the IP address of the panel and use the 
Browse button to navigate to a folder where the file will be saved.

Check Open the project and Close Download Manager.

Click on OK. The project is downloaded to your computer and opens in GUI 
Configurator.
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3.	 Depending on which option was selected in step 2, GUI Configurator opens to a new 
or an existing project. The initial screen is divided into a series of panes offering a 
range of tools that can be used to design or modify the project. For full details on how 
to use these tools, consult the help file (in the Help menu click on Contents or 
press the <F1> key while within the program).

 

Figure 21.	 GUI Configurator Main Screen

4.	 To save the project, select Save Project from the File menu. The project file is 
saved. If this is the first time saving the project file, the Save As dialog box appears. If 
the Save As dialog box appears:

a.	 Browse for the location where the project file is to be saved.

b.	 Enter a file name for the project.

c.	 Click Save.

5.	 The project can be uploaded to one or more TouchLink Panels. To add a panel, to 
which the project can be uploaded:

a.	 From the Project menu, select Add > Panel:

Figure 22.	Add a TouchLink panel (a)
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b.	 The Panel Manager dialog box opens:

Figure 23.	Add a TouchLink panel (b)

c.	 Click on the Add Panel icon to add a new panel to the list in the left 
pane.

d.	 Highlight the name of the panel in the left pane to display the properties of that 
panel in the right pane.

e.	 When a new panel is added, it has the default IP address (192.168.254.254). 
To change the IP address, highlight the address property and type in the correct 
IP address. Update any other properties, as required.

f.	 Repeat steps a - e to add further panels, if required.

6.	 To upload a project to a TouchLink panel:

a.	 From the Project menu, select Upload to Selected Panels. The 
Build Manager dialog box opens, showing the build progress. Once the build is 
complete, this dialog box closes and the File Upload Manager screen opens. The 
upload begins automatically.

b.	 Select Close this dialog when upload completes checkbox in 
the Automatic Settings section so that the File Upload Manager screen closes 
automatically once the upload completes. This option can be set before or during 
the upload.

If this project has been uploaded to the TouchLink Panel before, you can choose to 
upload the changes that have been made to the previous upload. You can also choose 
to upload to certain TouchPanels from the list of TouchLink Panels found within the 
Devices section of the File Upload Manager screen during the upload process. 
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Using Global Configurator

NOTE:	 To configure a TouchLink Panel, you must use Global Configurator version 3.0 
or later.

This section provides an overview of the Global Configurator program. For complete 
information about the program, consult the Global Configurator help file (click on 
Contents in the Help menu or press the <F1> key while within the program).

These instructions describe how to set up Global Configurator project with an IPL 250. 
Setting up a project with another IP Link product is similar but you should consult the 
Global configurator help file for exact information about the product you are using.

1.	 Click on the GC3 desktop icon. The Global Configurator 3 Start Options box 
opens.

 

Figure 24.	 Global Configurator 3 Start Options
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2.	 Select Create A New Project and click OK. The dialog box closes, leaving the 
Project Settings screen.

Figure 25.	 Global Configurator Project Settings

3.	 Enter the IP Address for the TLP 700MV panel.

The default Telnet connection is port 23 and HTTP is port 80, so these values do not 
usually need to be changed.

If necessary, set administrator and user passwords.

If required, set the date and time.

Leave the Set Device as GlobalViewer Host box checked.
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4.	 Click OK and the Project Settings screen closes and is replaced by the Add Device 
dialog box:

Figure 26.	 Global Configurator Add Device Dialog Box

To see all the options, click on the Advanced >>> button. The button name 
changes to Basic <<< (as shown in the figure above).

a.	 Select the IP Link device from the drop-down menu. In figure 26, above, an 
IPL 250 controller is added. Adding a different IP Link product is similar.

b.	 Enter the IP address of the IP Link controller. The default value is 
192.168.254.254, but this may have been changed. Check with your IT 
Department to verify the address.

c.	 Enter a Display Name into the text box. This is what the device will be known as in 
the Global Configurator project.

d.	 (Optional) Check the Make this device a GlobalViewer Host 
checkbox.

e.	 Set the telnet port (usually 23) and the web port (usually 80).

f.	 If the controller is password protected, enter the password now.

g.	 In the right pane, set up a GlobalViewer tree. For information about this, refer to 
the Global Configurator help file.
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5.	 Click OK and the Add Device screen closes. The start-up screen, which was behind 
it, is now visible. The device configuration tree, in the panel to the left of the main 
screen, shows the IPL 250 and the available ports:

Figure 27.	 Configuring an IP Link Device

6.	 Select Touchpanel Port 1. The screen shows the available options for the 
TouchLink Panel. To add the GUI Configurator project that was uploaded to the 
TouchLink Panel, click Click here to add one.

Figure 28.	 Adding a TouchLink panel
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7.	 The Add TouchPanel dialog box opens.

a.	 Ensure the correct model is selected from the drop-down menu.

b.	 Enter the IP address for the TouchLink Panel.

c.	 Set the Telnet Port (usually 23). 

d.	 If necessary enter the password.

e.	 Select the Import/Apply Layout check box.

f.	 Click OK.

Figure 29.	 Add Touchpanel Dialog Box.

8.	 The window now shows the GUI from the TouchLink Panel.

Figure 30.	 GUI from TouchLink Panel added to Global Configurator.

9.	 For complete instructions on how to assign functions to the buttons on the screen, 
see the Global Configurator help file, which is opened by clicking on Contents in 
the Help menu, or by pressing the <F1> key while within the program.
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Specifications
TLP 700MV

 Display
Screen type	������������������������������������ 	 Active matrix TFT color display
Size	������������������������������������������������ 	 7" (17.8 cm), measured diagonally
Resolution	�������������������������������������� 	 800x480
Dot/pixel pitch	�������������������������������� 	 134 dpi
Aspect ratio	������������������������������������ 	 Widescreen
Color depth	������������������������������������ 	 18 bit, 256k colors
Transparency	���������������������������������� 	 8 bit alpha channel
Brightness	�������������������������������������� 	 400 nits (cd/m2)
Contrast	����������������������������������������� 	 300:1
Backlight	���������������������������������������� 	 High bright LED
Viewing angle	�������������������������������� 	 ±70° horizontal, +50°/-70° vertical
Touch screen	���������������������������������� 	 Resistive membrane

 Memory
SDRAM	������������������������������������������ 	 128 MB for graphics processing 

8 MB for system use
Flash	���������������������������������������������� 	 32 MB for project storage 

16 MB for system use

 Control — Ethernet interface
Ethernet control/communications port 

1 RJ-45 female connector
Ethernet data rate	�������������������������� 	 10/100Base-T, half/full duplex with autodetect
Ethernet protocol	��������������������������� 	 ICMP, IP, TCP (control), UDP, DHCP, Telnet
Default settings	������������������������������ 	 Link speed and duplex level: autodetected 

IP address = 192.168.254.254 
Subnet mask = 255.255.0.0 
Default gateway = 0.0.0.0 
DHCP = off

Program control	����������������������������� 	 Extron Global Configurator 3.0 or higher 
GUI Configurator for Windows® 
Extron Simple Instruction Set (SIS™) 
Microsoft® Internet Explorer® ver. 6 or higher, Telnet

 Control — Touchpanel
Motion sensor	�������������������������������� 	 On/off
Light sensor	������������������������������������ 	 On/off
External buttons	����������������������������� 	 10 backlit, dual color (white, blue), field labelable

 Video input
Number/signal type	������������������������ 	 1 S-video or composite video
Connectors	������������������������������������ 	 2 female BNC
Nominal levels	�������������������������������� 	 1 Vp-p for Y of S-video and for composite video 

0.3 Vp-p for C of S-video
Impedance	������������������������������������� 	 75 ohms
Standards	��������������������������������������� 	 NTSC, PAL
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 Audio output
Speaker output	������������������������������ 	 1 mono, 86 dB SPL, 0.1 watt, 0.1 m, half space
Frequency response	������������������������ 	 400 Hz to 15 kHz, ±5 dB
Playback format(s)	�������������������������� 	 WAV files: 8 bit PCM, mono, 8 kHz sampling

 General
External power supply	�������������������� 	 100 VAC to 240 VAC, 50-60 Hz, external; to 12 VDC, 1 A, regulated
Power input requirements	�������������� 	 +12 VDC, 0.75 A
Temperature/humidity	�������������������� 	 Storage: -40 to +158 °F (-40 to +70 °C) / 10% to 90%, noncondensing 

Operating: +32 to +122 °F (0 to +50 °C) / 10% to 90%, noncondensing
Cooling	������������������������������������������ 	 Convection, no vents
Mounting

Rack mount	����������������������������� 	 With optional kit
Furniture or wall mount	����������� 	 With included hardware

Enclosure type	�������������������������������� 	 Plastic
Enclosure dimensions

Faceplate	��������������������������������� 	 7.1" H x 10.5" W x 0.6" D  
(18.0 cm H x 26.8 cm W x 1.4 cm D)

Enclosure	��������������������������������� 	 Including knob, excluding mounting flange: 
6.3" H x 9.4" W x 2.8" D* 
(16.0 cm H x 23.8 cm W x 7.2 cm D*) 
*In-wall depth, excluding knob: 2.25" (5.7 cm) 
(Allow at least 2.75" [7.0 cm] depth in the wall/furniture.)

FRONT VIEWSIDE VIEW

TLP 700MV
BOTTOM VIEW

9.366"
(23.79 cm)

6.316"
(16.04 cm)

7.056"
(17.92 cm)

2.248"
(5.71 cm)

0.568"
(1.44 cm)

2.816"
(7.15 cm)

10.507"
(26.69 cm)

Product weight	������������������������������� 	 2.3 lbs (1.0 kg)
Shipping weight	����������������������������� 	 5 lbs (3 kg)
Vibration	���������������������������������������� 	 ISTA 1A in carton (International Safe Transit Association)
Regulatory compliance

Safety	�������������������������������������� 	 CE, c-UL, UL
EMI/EMC	��������������������������������� 	 CE, C-tick,FCC Class A, ICES, VCCI
Environmental	�������������������������� 	 Complies with the applicable requirements of RoHS and WEEE.

MTBF	��������������������������������������������� 	 30,000 hours
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Warranty	���������������������������������������� 	 3 years parts and labor; touchscreen display and overlay components are covered 
for 1 year

NOTES: All nominal levels are at ±10%.

 Specifications are subject to change without notice.
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Specifications
TLP 700TV

 Display
Screen type	������������������������������������ 	 Active matrix TFT color display
Size	������������������������������������������������ 	 7" (17.8 cm), measured diagonally
Resolution	�������������������������������������� 	 800x480
Dot/pixel pitch	�������������������������������� 	 134 dpi
Aspect ratio	������������������������������������ 	 Widescreen
Color depth	������������������������������������ 	 18 bit, 256k colors
Transparency	���������������������������������� 	 8 bit alpha channel
Brightness	�������������������������������������� 	 400 nits (cd/m2)
Contrast	����������������������������������������� 	 300:1
Backlight	���������������������������������������� 	 High bright LED
Viewing angle	�������������������������������� 	 ±70° horizontal, +50°/-70° vertical
Touch screen	���������������������������������� 	 Resistive membrane

 Memory
SDRAM	������������������������������������������ 	 128 MB for graphics processing 

8 MB for system use
Flash	���������������������������������������������� 	 32 MB for project storage 

16 MB for system use

 Control — Ethernet interface
Ethernet control/communications port 

With base attached: 1 female RJ-45 connector 
Without base: 1 RJ-45 male connector on a pigtail

Ethernet data rate	�������������������������� 	 10/100Base-T, half/full duplex with autodetect
Ethernet protocol	��������������������������� 	 ICMP, IP, TCP (control), UDP, DHCP, Telnet
Default settings	������������������������������ 	 Link speed and duplex level: autodetected 

IP address = 192.168.254.254 
Subnet mask = 255.255.0.0 
Default gateway = 0.0.0.0 
DHCP = off

Program control	����������������������������� 	 Extron Global Configurator 3.0 or higher 
GUI Configurator for Windows® 
Extron Simple Instruction Set (SIS™) 
Microsoft® Internet Explorer® ver. 6 or higher, Telnet

 Control — Touchpanel
Motion sensor	�������������������������������� 	 On/off
Light sensor	������������������������������������ 	 On/off
External buttons	����������������������������� 	 10 backlit, dual color (white, blue), field labelable

 Video input — see S-video or composite video MTP transmitters' specifications
Number/signal type	������������������������ 	 1 S-video or composite video
Connectors	������������������������������������ 	 With base attached: 1 female RJ-45 connector 

Without base: 2 male BNC connectors on pigtails
Standards	��������������������������������������� 	 NTSC, PAL
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 Audio input — see S-video or composite video MTP transmitters' specifications

NOTE:	 Audio input is available only from an Extron MTP transmitter through the RJ-45 connector in the base of 
the unit. If the base is removed from the TLP 700TV, connections are via BNC connectors, and there is no 
audio input.

Number/signal type	������������������������ 	 1 stereo, balanced/unbalanced, line level, as part of a set of proprietary signals 
from an Extron MTP

Connector	�������������������������������������� 	 1 female RJ-45 (shared with video input)

 Audio output
Speaker output	������������������������������ 	 1 mono, 80 dB SPL, 0.1 watt, 0.1 m, half space
Frequency response	������������������������ 	 500 Hz to 16 kHz, ±5 dB
Playback format(s)	�������������������������� 	 WAV files: 8 bit PCM, mono, 8 kHz sampling

 General
External power supply	�������������������� 	 100 VAC to 240 VAC, 50-60 Hz, external; to 12 VDC, 3 A, regulated
Power input requirements	�������������� 	 +12 VDC, 0.75 A
Temperature/humidity	�������������������� 	 Storage: -40 to +158 °F (-40 to +70 °C) / 10% to 90%, noncondensing 

Operating: +32 to +122 °F (0 to +50 °C) / 10% to 90%, noncondensing
Cooling	������������������������������������������ 	 Convection, vents on top rear
Mounting

Furniture or wall mount	����������� 	 Set on tabletop or mount to optional VESA D 75 mm panel mount kit
Adjustment ranges	������������������������� 	 Tilts through a 45° range
Enclosure type	�������������������������������� 	 Plastic
Enclosure dimensions	��������������������� 	 7.7" H x 9.4" W x 8.2" D 

(19.6 cm H x 23.9 cm W x 20.7 cm D) 
(Includes base.  Total height and depth depends on screen tilt. See the following 
diagrams.)
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75° Min Tilt
30° Max Tilt

9.41"
(23.90 cm)

7.68"
(19.51 cm)

FRONT VIEW

SIDE VIEW

BOTTOM VIEW

TLP 700 TV

8.16"
(20.72 cm)

7.88"
(20.01 cm)

Extron

6.50"
(16.51 cm)

8.89"
(22.59 cm)

7.47"
(18.97 cm)

0.70" (1.78 cm)

5.10"
(12.95 cm)

7.68"
(19.51 cm)

Product weight	������������������������������� 	 3.8 lbs (1.7 kg)
Shipping weight	����������������������������� 	 7 lbs (3 kg)
Vibration	���������������������������������������� 	 ISTA 1A in carton (International Safe Transit Association)
Regulatory compliance

Safety	�������������������������������������� 	 CE, c-UL, UL
EMI/EMC	��������������������������������� 	 CE, C-tick, FCC Class A, ICES, VCCI
Environmental	�������������������������� 	 Complies with the applicable requirements of RoHS and WEEE.

MTBF	��������������������������������������������� 	 30,000 hours
Warranty	���������������������������������������� 	 3 years parts and labor; touchscreen display and overlay components are covered 

for 1 year

NOTES: All nominal levels are at ±10%.

 Specifications are subject to change without notice.
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Accessories and 
Part Numbers

Included Parts

Description Part Number

TLP 700MV TouchLink Panel (wall mount) 60-546-0x

TLP 700TV TouchLink Panel (desktop or VESA mount) 60-548-02

12 VDC, 1A power supply for TLP 700MV 70-775-01

12 VDC, 3A power supply for TLP 700TV 70-380-01

TR 700M trim ring (for TLP 700MV)

TLP 700MV button labels 33-1792-01

TLP 700TV button labels 33-1793-01

Extron Software Products DVD

TLP 700MV • Setup Guide or TLP 700TV • Setup Guide

Optional Parts

Description Part Number

RM 700M rack mounting kit for TLP 700MV 70-683-01

BB 700M back box for TLP 700MV 70-690-01

EWB 700 box for TLP 700MV 60-1100-0x

VM 700T VESA mounting plate for TLP 700TV 70‑692‑01

LPVM-1 VESA mounting kit for TLP 700TV 60-1099-02

Bezel kit for TLP 700MV 60-546-0x

Bezel kit for TLP 700TV 60-548-02

TLP 700MV button labels (default side buttons) 33-1792-02

TLP 700TV button labels (default side buttons) 33-1793-02

IPL T S1 60-801-81

IPL T S2 60-544-81

IPL T S4 60-544-83

IPL T S6 60-544-84

IPL 250 60-1026-81

IPL T CR48 60-544-05

IPL T SFI244 60-544-86

4-pin Mini DIN Female to 2 BNC Male Adapter - various lengths 26-354-0x
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Mounting

This section outlines the various options for:

zz Rack Mounting the TLP 700MV

zz Wall Mounting the TLP 700MV

zz Wall Mounting the TLP 700MV with a Wallbox

zz Desktop Mounting the TLP 700TV

zz Removing the TLP 700TV base for VESA Mounting

zz VESA mounting the TLP 700TV

Rack Mounting the TLP 700MV

Underwriters Laboratories Guidelines for Rack Mounting
The following Underwriters Laboratories (UL) guidelines are relevant to the safe installation 
of these products in a rack:

Elevated operating ambient temperature — If the unit is installed in a closed or 
multi-unit rack assembly, the operating ambient temperature of the rack environment 
may be greater than room ambient temperature. Therefore, install the equipment in an 
environment compatible with the maximum ambient temperature (Tma: +122 °F, +45 °C) 
specified by Extron.

Reduced air flow — Install the equipment in the rack so that the equipment gets 
adequate air flow for safe operation.

Mechanical loading — Mount the equipment in the rack so that uneven mechanical 
loading does not create a hazardous condition.

Circuit overloading — Connect the equipment to the supply circuit and consider the 
effect that circuit overloading might have on overcurrent protection and supply wiring. 
Give appropriate consideration to the equipment nameplate ratings when addressing this 
concern.

Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted 
equipment. Pay particular attention to supply connections other than direct connections to 
the branch circuit (such as the use of power strips).

Rack Mounting the TLP 700MV
The TLP 700MV can be mounted in any standard 19-inch equipment rack, using the 
optional Extron RM 700M rack mounting kit (part number 70-683-01). Follow the 
instructions provided with the kit.
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Wall Mounting the TLP 700MV
The TLP 700MV can be mounted in the wall or through furniture. Extron recommends 
using the Extron TR 700M trim ring to conceal any ragged edges when the hole is cut in 
the wall or furniture.

To mount the TLP 700MV directly into a wall, follow these steps. The steps are similar if 
the unit is mounted in furniture (such as a podium or table).

1.	 Determine the best location for the TLP 700MV.

2.	 Use the template provided to mark the wall or furniture and cut a hole.

3.	 Unpack the TLP 700MV and remove the bezel.

4.	 Ensure all the locking arms are flush with the unit and check that the TLP 700MV can 
fit into the hole. If necessary, use a rasp or a coarse file to enlarge the hole.

5.	 Place the TR 700M trim ring around the hole. Ensure the trim ring is horizontal (use 
a level if necessary) and mark the four holes (one in each corner) where it will be 
secured around the hole.

6.	 Drill four holes and secure the trim ring to the wall, covering any ragged edges to the 
hole.

7.	 Run the network cable and video connectors inside the wall to the hole, leaving 
enough slack in the cables to connect them to the back of the TLP 700MV.

8.	 Plug the cables into the rear panel connectors (see page 7).

Connect the LAN port to the network with a straight-through cable.

Connect an S-video or composite video source to the unit, using the two BNC 
connectors:

zz For S-video, connect the Y (luminance) signal to the VID/Y input and the C 
(chrominance) signal to the C input.

zz For composite video, connect the input to the VID/Y input.

Connect the power input to the provided power supply using the 2-pole captive 
screw connector. See the Caution on page 6 for very important information about 
power supplies.

9.	 Push excess cables into the wall cavity and fit the TLP 700MV into the hole.

10.	Use a Phillips head screwdriver to tighten the screws. As the screws tighten, the 
locking arms rotate into position behind the wall and hold the unit in place. Do not 
overtighten the screws as this can damage the catches or the wall.
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Trim Ring
Screws (4)

Tighten screws to
rotate locking arms.

Bezel snaps to unit
(4 plcs ea side).

Figure 31.	 Secure the TLP 700MV to a Wall With Locking Arms

11.	If required, perform the initial calibration (see page 11).

12.	Replace the bezel by pressing the catches on the bezel into the corresponding holes 
on the front of the panel. 

Wall Mounting the TLP 700MV with a Wall Box
The TLP 700MV can be wall mounted using either the Extron BB 700M (part number 
70‑690‑01) or the Extron EWB 700 (part number 60‑1100‑0x). In either case follow the 
instructions provided with the wall box.
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Desktop Mounting the TLP 700TV
The TLP 700TV comes assembled with a stand that allows it to be placed on a desktop. 
If required, the stand can be removed and replaced with the Extron VM 700T kit 
(part number 70‑692‑01). This kit fits into any third-party VESA Type D 75 mm wall mount 
system.

To mount the TLP 700TV on a desktop, place the unit in a suitable position and, if 
required, use two screws through the two holes in the base to secure the unit to the 
desktop.

NOTE:	 Use the potentiometers to adjust the sharpness and gain (see page 10) 
before securing the base to the desktop.

C G
ain

Vid / Y
G

ain

Sharp
33-1814-01 A

Use two 8-32 screws
through these holes
to secure the base
to the desk top.

Adjustable
Potentiometers

Figure 32.	Base of TLP 700TV

1.	 Drill two holes through the desktop from underneath. The two holes must be 
5.1 inches (13 cm) apart.

2.	 Use two 8-32 wood screws through the desktop from underneath into the two holes 
in the base. 

Insert the power supply, the network, and twisted pair video cables to the connectors 
on the back of the stand.

CAUTION: 	 The left RJ-45 connector on the back of the TLP 700MV (with the 
yellow and green LEDs) must be connect to a network. The right 
RJ‑45 connector must be connected to an Extron MTP Transmitter. The 
MTP transmitter uses higher voltages than a LAN and inputting those 
voltages on the network connection damages the TLP 700MV.

Removing the TLP 700TV Base for VESA Mounting
Extron provides two kits for wall mounting the TLP 700TV.

zz The VM 700T is an adapter that is used to mount the TLP 700TV to any third party 
VESA D-type (75 x 75 mm) mounting kit.

zz The LPVM-1 is used to wall mount a monitor with either the B-type (20 x 50 mm) or 
the D-type (75 x 75 mm) mounting patterns.

CAUTION: 	 The maximum loads for the LPVM-1 are: 
VESA B — 4.4 pounds (2 kg) 
VESA D — 30.8 pounds (14 kg) if the LPVM-1 is mounted directly 
to the wall, not a mud ring.

To use either of these kits, it is essential to remove the base and the plastic enclosure from 
the back.

NOTE:	 When the base is removed from the TLP 700TV, video connections are via BNC 
connectors, and there is no audio input.
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To prepare the TLP 700TV for wall mounting, using either kit, follow these instructions:

1.	 Remove the TLP 700TV from its packaging or, if the TLP 700TV has previously been 
used as a free-standing, desktop unit, remove all cables to the back of the base.

2.	 At the bottom, the two plastic cover plates for the stand are held together by a 
Phillips head screw near the base. Remove the screw in the recessed slot at the front 
of the stand, close to the base.

2

Figure 39.	 Remove Screw.

3.	 At the top, the two plastic plates covering the stand are held together by four locking 
tabs on the back cover plate fitting into four slots on the front cover plate. Squeeze 
the sides of the front plate at the top so that the tabs are no longer seated in the 
slots.

33

Figure 40.	 Squeeze Sides of the Back Cover.
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4.	 Remove the back cover to reveal the metal stand and the cables connecting the circuit 
board in the base to the touchpanel screen.

4

Figure 41.	 Remove Back Cover.

5.	 Cut the plastic tie holding the cables to the metal stand.

6.	 Disconnect the power, LAN, audio, LED, and two BNC cables from the circuit board in 
the base.

7.	 Remove the snake-skin cover protecting the cables.

7

5

6

Figure 42.	 Steps 5, 6, and 7

8.	 Tilt the screen down to reveal the Phillips head screws securing the monitor to the 
hinged bracket at the top of the stand. Remove and save the screws for later use.

8

Figure 43.	 Remove Screws.
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9.	 Thread the cables through the gap between the top bracket and the stand. Place the 
screen, face down, on a soft cloth.

9

Figure 44.	 Thread Cables into Place.

10.	Remove and save the three Phillips head screws holding the plastic molding to the 
back of the screen.

10

Figure 45.	 Remove Molding.
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11.	Disconnect the audio, LED, and power cables from the back panel of the screen.

zz The audio cables are the black and white pair, wound around a ferrite core.

zz The power cables are the red and black pair, terminated with a blue, 2-pole 
captive screw connector.

zz The LED cables are the black and white pair, without a ferrite core.

11

Figure 46.	 Disconnect Cables.

NOTES:	 None of the cables that are connected with a plastic tie should be 
disconnected. 
 

Save the blue power cable connector for later use.

12.	Replace the orange 2-pole captive screw connector on the provided power supply 
with the blue connector from the power cable disconnected in step 11.

CAUTION: 	 The power supply provided with the TLP 700TV is intended for use 
with the power supply input in the base. To use the power supply 
with the rear panel power input, the captive screw connector must be 
replaced.

VESA Mounting the TLP 700TV
Before attaching the VESA mounting kit, remove the base and back of the TLP 700TV, as 
described in the previous section.

Once the base and back have been removed, the TLP 700TV can be VESA mounted using 
either the Extron LPVM-1 (part number 60-1099-02) or the Extron VM 700T mounting 
plate (part number 70-692-01).

NOTE:	 The Extron VM 700T only provides a mounting plate, which is attached to 
the back of the TLP 700TV. It must be used together with a third party VESA 
mounting kit.

To VESA mount the TLP 700TV with the LPVM-1, follow the instructions provided with 
the mounting kit. To mount the TLP 700TV with the VM 700T and a third-party VESA 
mounting kit, follow the instructions provided with the VM 700T and the third-party kit.
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Reset Modes

The TLP 700MV and TLP 700TV have four reset modes that correspond to four of the 
five reset modes for the IP Link controllers. The modes are initiated by pressing the Reset 
button.

To access the Reset button on the TLP 700MV, remove the bezel. See page 5 to locate the 
Reset button on the TLP 700MV. The Reset button on the TLP 700TV is recessed behind 
the bezel, which cannot be removed. It is necessary to use a pen or paper clip to press it. 
See page 8 to locate the Reset button on the TLP 700TV.
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The TLP 700 reverts to the factory default 
firmware.  Event scripting does not start if the 
TLP 700 is powered on in this mode.  All user files 
and settings (drivers, adjustments, IP settings, etc.) 
are maintained.

TLP 700MV and TLP 700TV Reset Mode Summary
  Mode Activation Result Purpose/Notes

 1 Hold down the recessed Reset 
button while applying power to the 
TLP 700.

This mode reverts to 
the factory default 
firmware version if 
incompatibility 
issues arise with 
user-loaded 
firmware.

 3 Hold down the Reset button for 
about 3 sec. until the Reset LED 
blinks once, then release and press 
Reset momentarily (<1 sec.) within 
1 second.

 4 Hold down the Reset button for 
about 6 sec. until the Reset LED 
blinks twice (once at 3 sec., again at 
6 sec.).  Then release and press Reset 
momentarily (for <1 sec.) within 
1 second.

This Mode turns events on or off.

This Mode:
• Enables ARP  capability.
• Sets the IP address back to factory default 

(192.168.254.254).
• Sets the subnet back to factory default.
• Sets the default gateway address to the factory 

default.
• Sets port mapping back to factory default.
• Turns DHCP off.
• Turns events off.

This mode is useful 
for troubleshooting.

 5 Hold down the Reset button for 
about 9 sec. until the Reset LED 
blinks three times (once at 3 sec., 
again at 6 sec., again at 9 sec.).  
Then release and press Reset 
momentarily (for <1 sec.) within 
1 second.

This Mode performs a complete reset to 
factory defaults (except the firmware).
• Does everything mode 4 does.
• Removes button/touchpanel configurations.
• Resets all IP options.
• Removes scheduling settings.
• Removes/clears all files from TLP 700.

This mode is useful 
if you want to start 
over with 
configuration and 
uploading, and also 
to replace events.

This mode enables 
you to set IP address 
information using 
ARP and the MAC 
address.

NOTE:  
User-defined web 
pages may not 
work correctly if 
using an earlier 
firmware version.

NOTE:  If you do not want to update firmware, or 
you performed a mode 1 reset by mistake, cycle 
power to the TLP 700 to return to the firmware 
version that was running prior to the mode 1 
reset.  Use the 0Q SIS command to confirm that 
the factory default firmware is no longer 
running (look for asterisks following the version 
number).

NOTE:  After a mode 1 reset is 
performed, update the TLP 700 
firmware to the latest version.  Do 
not operate the firmware version 
that results from this mode reset.  
If you want to use the factory 
default firmware, you must upload 
that version again.  See page 17 
for details on uploading firmware.

NOTE:  Nothing happens if the momentary press 
does not occur within 1 second.

NOTE:  Nothing happens if the 
momentary press does not occur 
within 1 second.

NOTE:  Nothing happens if the 
momentary press does not occur 
within 1 second.
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Button Labels

This section provides information about:

zz Button Label Software

zz Replacing Button Labels

Button Label Software

Installing or Replacing Button Labels
Printed labels are included with the TLP 700MV and TLP 700TV. In addition, users can 
write on blank labels, purchase additional sheets of printed button labels from Extron (see 
page 37) or print their own customized button labels with the Button Label Generator 
program. Replacement button caps are also available for purchase.

Button Label Generator Software
The Button Label Generator software creates labels that you can place in the translucent 
covers above the buttons. You can create labels with names, alphanumeric characters, or 
color graphics for easy and intuitive input and output selection.

Installing the Button-Label Generator Software
The Extron Button Label Generator is available on the Extron web site, www.extron.
com, under the Download tab. Click the Software link, and download and install the 
program by following the on-screen instructions.

NOTE:	 The Button Label Generator software is also included on the Extron Software 
Products disc that accompanies the TouchLink Panel.

By default, the Windows installation creates a C:\Program Files\Extron\
ButtonLabelGenerator directory and places the Button Label Generator icon into a 
group or folder named Extron Electronics. A shortcut icon can also be placed on 
the PC desktop.

TLP 700MV and TLP 700TV • Button Labels 47

http://www.extron.com
http://www.extron.com


Using the Button-Label Generator software
1.	 To run the Button-Label Generator program, click on the desktop icon. Alternatively, 

click Start > Programs > Extron Electronics > Button Label 
Generator > Button Label Generator. The Button-Label Generator 
window appears:

Figure 47.Button Label Generator Software

2.	 In the Systems selection box, choose the TLP 700MV or the TLP 700TV option to 
match the button label size and quantities for your TouchLink Panel.

3.	 Using standard Windows controls, you can create and print labels that can be placed 
in the clear button caps on the front panel of the switcher.

4.	 Click the Clear All Buttons button and create new labels as many times as 
necessary to make all of the button labels that you need.

To access the help program, click the Help menu.
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Replacing Button Labels
The illustration below shows how to replace the button labels on the TLP 700MV. 
Although, the buttons on the TLP 700TV are slightly smaller and the labels are different 
dimensions, the procedure for replacing labels on either model is the same. To change the 
translucent button labels for either model, follow these steps, as shown in the diagram:

TEXT

Pull the lens from the button
and add the label.

Button Label

Clear Lens

Figure 48.Removing Buttons

1.	 Pull off the clear plastic lens covering the button using the thumb and forefinger.

2.	 If necessary, remove the existing label; it may be inside the lens or the top of the 
button plunger.

3.	 Place the new label inside the plastic lens. Ensure that the label and the lens are in the 
correct orientation.

4.	 Align the plastic lens with the button plunger and firmly snap it into place.

5.	 Repeat steps 1 to 4, as needed, to relabel all the buttons.
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Extron® Warranty
Extron Electronics warrants this product against defects in materials and workmanship for a period of 
three years from the date of purchase; touchscreen display and overlay components are covered for 1 
year. In the event of malfunction during the warranty period attributable directly to faulty workmanship 
and/or materials, Extron Electronics will, at its option, repair or replace said products or components, to 
whatever extent it shall deem necessary to restore said product to proper operating condition, provided 
that it is returned within the warranty period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America:
Extron Electronics
1001 East Ball Road 
Anaheim, CA 92805 
U.S.A.

 
Japan:
Extron Electronics, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe, Africa, and the Middle East:
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China:
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Asia:
Extron Asia 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Middle East:
Extron Middle East 
Dubai Airport Free Zone 
F12, PO Box 293666 
United Arab Emirates, Dubai

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, 
electrical or mechanical abuse, abnormal operating conditions, or modifications made to the product that 
were not authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA 
(Return Authorization) number. This will begin the repair process. 
 
USA:	 (714) 491-1500			   Europe:	 +31.33.453.4040 
Asia:	 +65.6383.4400			   Japan:		 +81.3.3511.7655 

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of 
loss or damage during shipment. Returned units must include the serial number and a description of the 
problem, as well as the name of the person to contact in case there are any questions. 

Extron Electronics makes no further warranties either expressed or implied with respect to the product 
and its quality, performance, merchantability, or fitness for any particular use. In no event will Extron 
Electronics be liable for direct, indirect, or consequential damages resulting from any defect in this 
product even if Extron Electronics has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this 
warranty may not apply to you.



Extron USA - West
Headquarters

+800.633.9876
Inside USA/Canada 
Only

+1.714.491.1500
+1.714.491.1517 FAX

Extron USA - East

+800.633.9876
Inside USA/Canada 
Only

+1.919.863.1794
+1.919.863.1797 FAX

Extron Europe

+800.3987.6673
Inside Europe Only

+31.33.453.4040
+31.33.453.4050 FAX

Extron Asia

+800.7339.8766
Inside Asia Only

+65.6383.4400
+65.6383.4664 FAX

Extron Japan

+81.3.3511.7655
+81.3.3511.7656 FAX

Extron China

+400.883.1568
Inside China Only

+86.21.3760.1568
+86.21.3760.1566 FAX

Extron Middle East

+971.4.2991800
+971.4.2991880 FAX
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Installation Checklist

Installation of the TLP 700MV and TLP 700TV can be divided into five main sections:

Step 1 — Mount the TouchLink panel (select one option):

�� Rack mount the TLP 700MV (page 38).

�� Wall mount the TLP 700MV with (page 40) or without (page 39) an Extron wall box.

�� Mount the TLP 700TV on a desktop (page 41).

�� VESA mount the TLP 700TV (page 45).

�� If required, replace the buttons on the front panel (see page 49).

Step 2 — Connect the power, network, and video cables, (select one option):

�� Cable the TLP 700MV (page 6).

�� Cable the desk-top mounted TLP 700TV (page 9).

�� Cable the VESA mounted TLP 700TV (see the user guide for VESA mount kit online at 
www.extron.com).

Step 3 — Initial configuration with internal on-screen menus:

�� Configure the TouchLink Panel, using the on-screen menus (page 11).

�� Carry out Touch Screen calibration (page 14).

Step 4 — Install and update software:

�� Connect a PC to same network as the TouchLink Panel (for PC requirements, see page 3)

�� Connect an IP Link controller to the same network (for a list of suggested models, see 
page 3).

�� Install GUI Configurator and Global Configurator on the PC (page 16).

Step 5 — Design and configure graphical user interface:

�� Use GUI Configurator to design a new graphical user interface project for the 
TouchLink Panel (see page 21 and the GUI Configurator help file).

�� Save and upload the project to the TouchLink Panel (see page 24).

�� Create a new Global Configurator project for the IP Link controller (see page 26 and 
Global Configurator help file).

�� In Global Configurator, import and configure the GUI Configurator project (see 
page 29 and Global Configurator help file).

http://www.extron.com
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